AVR-Simulator

https://www.mikrocontroller.net/topic/420097

Das Programm soll Anféangern unter Linux helfen, die ersten Schritte in der
Assemblerprogrammierung fiir AVR zu bewdltigen, ohne in teure und aufwéandige
Hardwaredebugger (und Bausteine, die HW-Debugging unterstiitzen) investieren zu miissen. Auch
wenn es nicht den Funktionsumfang des Simulators im AVR-Studio erreichen wird, wird es auch
interessierten Windows-Nutzern als Bindrpaket zum Ausprobieren, zur Verfiigung gestellt.

Hintergrund

Das Programm entstand vor dem Hintergrund, das AVR-Studio 4 unter WINE nur sehr
unzuverléssig funktioniert. Die Kombination aus "simulavr" + "avr-gdb" und gegebenenfalls
"DDD" funktioniert gut, fiir Projekte die {iberwiegend in C erstellt sind. Kleine Projekte, die
ausschlief8lich in Assembler programmiert sind, lassen sich nur auf Bindrebene debuggen, was wohl
auch daran liegt, das der gdb auf die Debug-Informationen in der ELF-Datei angewiesen ist, welche
aber nicht alle Assembler erzeugen. Aulerdem erscheint dieses Konstrukt gerade fiir Jemanden, der
gerade erst in die Mikrocontrollertechnik einsteigen mochte, meiner Meinung nach, etwas
abschreckend.

Zweck

Simuliert wird primér der Prozessorkern (CPU). Die zukiinftige Implementierung allgemeiner
Peripherie ist angedacht. Hier kommen primdr Komponenten in Frage, die in vielen Bauelementen
in gleicher Weise implementiert sind. Bis dahin werden die I/O-Register wie RAM behandelt,
konnen also beschrieben, und auch wieder zuriick gelesen werden.

Gelesen werden Objektdateien (.obj), die sowohl vom proprietiren AVRASM?2, dem freien avra,
sowie dem ebenfalls freien Universalassembler "AS" von Alfred Arnold geschrieben werden
konnen. Diese enthalten neben dem eigentlichen Programm, auch Informationen, zu den
urspriinglichen Quelldateien.

Ebenfalls ist es auch moglich, Intel-Hexdateien (.hex) einzulesen. Da hier aber keine Debug-
Informationen vorliegen, kann der Programmablauf hier nur anhand der Disassemblerausgabe
verfolgt werden.

Installation

Der Simulator wird im Quelltext bereitgestellt und benutzt das FLTK-Framework.

Linux

Bevor das Programm compiliert werden kann, ist sicherzustellen, das FLTK installiert ist:

sudo apt-get install libfltkl.3-dev
sudo apt-get install libxll-dev

Im Verzeichnis "src" befindet sich das Shellscript "c", welches die Compilierung durchfiihrt.


https://www.mikrocontroller.net/topic/420097
https://de.wikipedia.org/wiki/Fast_Light_Toolkit
http://john.ccac.rwth-aachen.de:8000/as/

Die entstandene Programmdatei "avrsim" kann dann bei Bedarf, an einen geeigneteren Ort
verschoben werden.

MS-Windows

Fiir win32, wird ein kompiliertes Paket bereitgestellt, welches die erforderlichen MinGW-
Bibliotheken, das statisch gelinkte Programm, sowie erforderliches Zubehor enthélt.

Fiir beide Plattformen, werden zusétzlich, die Hardwaredefinitionen (Iodefs) benotigt.

Einrichtung

Wird das Programm das erste Mal gestartet, liegen noch keine Informationen tiber die Art des zu
simulierenden Prozessors vor. Fiir die I/O-Ports konnen daher keine Namen angezeigt werden.

AVR-Simulater
File View Debug

Position of S5REG is not Known! J
Please select definitions-file!

(| [»]
I"‘D'DI roa |00 r15| r24 |00

rol |0 ro9 {00 rl7 |0 r25 |00

roz2 EII:I rlo oo ris UU rZ2e |00

ro3 |00 rll |00 rl19 |00 r27 |00

ro4 |00 rl2 (oo r20 (00 r28 |00

rds |00 rls |00 rZl |00 r29 100

rle |00 rl4 |00 r22 |00 r230 00

ro7 |00 rls |oo rZ3 |00 r3l |00

Cycles [0 Time [0.0 ns

PC |0000 Breakp-nintlﬂﬂ[lﬂ

Diese Informationen werden aus Definitionsdateien (*.def) gelesen, die aus Standard-
Includedateien des AVRASM?2 abgeleitet und manuell bearbeitet wurden. Diese Dateien konnen aus
dem Archiv "iodefs", an einen Ort nach Wahl entpackt werden. Anschliefend wird die
Definitionsdatei fiir den gewiinschten Prozessortyp ausgewdhlt (View->Settings):



Include Path |

CPU Definition hum e/nutzer/eigene/prj/avr/avrsim/iodefs/mB8.def]
CPU Speed [1000000 ‘

OK

Aus diesen Dateien wird insbesondere die Lage des Statusregister, der Stackpointer, die
Speicherlimits, sowie die Struktur und Benennung der I/0-Register bezogen.

Die CPU-Geschwindigkeit wird zur Berechnung der abgelaufenen Zeit im Hauptfenster benétigt.

Include Suchpfad

Je nach Gestaltung der Quellen, enthdlt die Objektdatei unter Umstdnden nicht den vollstdndigen
Pfad zur entsprechenden Quelldatei. Falls eine Datei ohne Pfad angegeben ist, wird als Erstes
versucht, sie im Verzeichnis der Objektdatei zu finden.

Sollten die Includedateien "anderswo" stehen und dieser Pfad dem Assembler per
Kommandozeilenargument mitgegeben werden, kann der Simulator unter "View->Settings",
Includepath dariiber unterrichtet werden. Hier kdnnen bis zu 10 Verzeichnisse, durch Doppelpunkt
voneinander getrennt, angegeben werden.



Benutzung

Die Benutzeroberfldche besteht aus dem Hauptfenster, sowie einzeln ein/ausblendbaren Fenstern fiir
Disassemblerausgabe, Quelltext, RAM, Flash, In/Output und einem Terminalfenster. Letzteres hat
noch experimentellen Charakter und zeigt die Zeichen an, die in das SBUF-Register geschrieben
werden.

Die zu simulierende Programmdatei wird mit "File->Load Code File" in den virtuellen Flash
geladen.

Die Oberfldche fiir die Benutzereingaben, orientiert sich fiir die bisher verfiigbaren Funktionen am
AVR-Studio 4.

BE6E: DEOL reall 888D .include "Appnotes/m8def.inc" 0|1|2|3|4|5|6|7|8|9|A|B|C|D|E|F
ggggf g;;ﬁ erg ﬂfg? ] 000000 00 00 00 0000 00 00|00 00 00 00 00 00 00 00
oooe. 237r gﬂ:h :13 1di Fl?,lw{rami?ﬂd) 0010|580 00 00|00 00 00|00 00/ 00|00 00 00|00 00 00|00
8BBF: 933F push r19 ?gi iga}rﬁah{ramend} 0020|0000/ 00/00/00/00/00/00/00/00/00/00/00/00/00/00
8018: E31B 1di rl7,8x3b out sph}rlg 0030 00/00 00 00 00|00 00 FF Bl 00 00 00 00 00 00|00
g@1l: E@2D ldi rl8s,éxad ! 0040|0000 00|00 00| 00|00 00 00|00 00| 00|00 00 00|00
ggﬁ; Egﬂ lﬁzirﬁ}a;ggl 1di ri6,0xff 0050|0000/ 00/00/00/00/00/00/00/00/00|00/00|5F 0415
0014: 4620 sbci rl8.8x00 out ddrb, r16 006000 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
8015: 4830 shci r19,8x00 ldi rig,1 0070|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
B016: FTEE brcc 8xB013 Loop: 1 0080|0000/ 00 00 00 00|00 00|00/ 00 00 00 00|00 00 00
0017: 913F pop rl9 sr rlg 0090|0000/ 00/00/00/00/00/00|00/00/00/00/00/00/00/00
Bolg: 912F pop 1B brcc  no_carry 00AD|00 00 00 00 00|00 00|00 00 00 00 00|00 00 00 0O
8819: 911F pop rl7 shr rl6,0x80
901A: 9508 ret no_carry: 00B0| 00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
801B: FFFF ill opc OxXFFFF - out portb,rl6 00CD| 00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
ggi? EEEE 1{{ opc gXEEEE rcall  delay 00D0|00 00 00|00 00/ 00|00 00/ 00|00 00 00|00 00 00|00
: i opc Bx :
B ool nlcl ool cnocio
BO1F: FFFF ill opc OxFFFF . _— "
§026: FFEF ill opc @xFFFE -include "zweite.asm 0100|0000 00 00 00|00 00 00|00 00 00 00 0D 00 00 00
ggg: EEEE 1“ opec EXEEEE 0110|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
: i opc Bx
B33, EFFEF 111 obc OXFFFF 0120|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
00824: FFFF ill opc BXFFFF 0130|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
8825: FFFF ill opc OxFFFF 0140|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
8626: FFFF ill opc BXFFFF 0150|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
oy TrEr m one e 016000 00 00 0D 00|00 00|00 00 00 00 00|00 00 00 0D
0029: FFEF i1l opc BXFEFE 0170|00 00|00 00 00|00 00 00|00 00 00 00 00 00 00|00
802A: FFFF ill opc OxFFFF 018000 00|00 00 00|00 00 00/ 00 00 00 00 00 00 00|00
802B: FFFF ill opc OxXFFFF 019000 00|00 00 00|00 00 00|00 0000|0000 00 00|00
B@2C: FFFF ill opc @xFFFF 01AD|00 00 00|00 00 00|00 00 00|00 00 00|00 00 00|00
Be2D: FFFF ill opc BxFFFF
BO2E: FFFF ill opc OxFFFF
802F: FFFF ill opc OxFFFF
8030: FFFF ill opc OxFFFF [EROOT
8831: FFFF ill opc OxFFFF -[¥] ANALOG_COMPARATOR
8832: FFFF ill opc OxFFFF SPT
0833: FFFF ill opc @xFFFF EXTERNAL INTERRUPT
8034: FFFF ill opc OxFFFF TIMER COUNTER 6
0835: FFFF ill opc @xFFFF File View Debug TIMER COUNTER 1
8036: FFFF ill opc OxFFFF —r— =
0037: FFFF ill opc BxFFFF N | » | n | 1 | "’_=| l_=| TIMER _COUNTER_2
00335 FFFF ;ll opc BxFFFF T-8 T-0 H=B 5-1 V=0 N1 7=8 (-1
0e39: FFFF Ll ope BxFFFF SP=045f X=0000 Y=0000 Z=0000 ]
803A: FFFF ill opc OxFFFF = = = = -[¥] WATCHDOG
803B: FFFF ill opc OxFFFF p
803C: FFFF ill opc OxFFFF - : -
003D: FFFF ill opc BxFFFF roofoo | ro8foo | riefso | r24fo0 38 PORTE = B0 ;Port B Data Register
983E: FFFF ill opc @xFFFE 101 o0 r09 [a0 1750 125 [00 37 DDRB = ff ;Port B Data Dlrectlon Reg)
B03F: FFFF ill opc OxFFFF 36 PINB = 80 ;Port B Input Pins
P r0z o0 r10[o0 r18[00 r26 [00
8040: FFFF ill opc OxFFFF
8041: FFFF ill opc OxFFFF r03)00 ri1joo ris)oo 0
8842: FFFF ill opc OxFFFF r04 [00 r12 [oo r20 [00 r28 [00
8043: FFFF ill opc OxFFFF 0500 11300 2100 2900
8044: FFFF ill opc OxFFFF B ) )
8045: FFFF ill opc BxFFFF r6 |00 rld |oo r22 |00 r30 oo = 15 ;5tatus Reglster.
B846: FFFF ill opc @xFFFF r07 (00 rl5 00 r23 (00 r31 |00 = 88 ;MCU Control Register
MCUCSR = B8 ;MCU Control And Status Re
= 1100 s 0SCCAL = B0 ;0scillator Calibration Va
PC [000OB BreakpnlnthOOO = B8 ;Store Program Memory Cont
= B0 ;Special Function IO Regis
= 5f ;SPL
= 84 ;SPH
_[¥] AD_CONVERTER




Hauptfenster

Im Hauptfenster befinden sich Eingabefelder fiir die Register r0 bis r31. Die Registerinhalte kdnnen
manuell gedndert werden. Der gednderte Wert wird wirksam, wenn das Eingabefeld den Fokus
verliert (Tabulator). Uber das Hauptfenster wird der Simulator gesteuert (Meniis, Hotkeys oder
Schaltfldchen), sowie werden die restlichen Fenster sichtbar/unsichtbar gemacht (View-Menii).

Run

Das Programm lduft im Hintergrund, ohne Aktualisierung der Anzeigen, mit voller
Geschwindigkeit, bis zum gegebenenfalls gesetzten Haltepunkt.

Break

Damit kann das Programm abgebrochen und inspiziert werden.

Reset

Ein gegebenenfalls laufendes Programm wird abgebrochen, der Befehlszdhler und die Stoppuhr
zuriickgesetzt und das Programm neu in den Flash geladen (fiir den Fall, dass es inzwischen
gedndert worden sein sollte).

Step Into

Es wird ein Prozessorbefehl ausgefiihrt. Sollte es sich dabei um einen Call handeln, ist der ndchste
Befehl, der erste der Subroutine.

Step Over

Sollte es sich hier um einen Call handeln, wird die gesamte Subroutine ausgefiihrt. Falls das
Programm in der Subroutine "hdngen" sollte, kann die mit Break unterbrochen und inspiziert
werden.

Step Out

Hier werden alle Befehle ausgefiihrt, bis die Routine mit RET beendet wird ausgefiihrt.

Auto Step

Das Programm lduft, bis es mit Break unterbrochen wird. Dabei wird der Prozessorstatus auf dem
Bildschirm angezeigt, was ein Vielfaches der Zeit benétigt ;-)

Die Stoppuhr

Im Eingabefeld "Cycles" wird ein Zdhler der ausgefiihrten Taktzyklen gefiihrt. Dieser kann bei
Bedarf manuell "genullt", oder wie gewiinscht gedndert werden. Von Diesem abhdngig, ist die
Anzeige "Time". Diese setzt voraus, das unter "View->Settings" die richtige Taktfrequenz (CPU
Speed, in Hz) eingestellt ist.



Breakpoint

Bisher ist ein Haltepunkt einstellbar (wird sich hoffentlich bald &ndern). Ein eingestellter Wert von
0 kommt nur zum Tragen, wenn der PC iiberlduft, oder ein Sprungbefehl auf diese Adresse
stattfindet.

RAM und Flash

Diese Speicherbereiche werden als Tabelle dargestellt. Eine Zelle kann durch Anklicken gedndert
werden, dann erscheint ein Eingabedialog (derzeit bitte als Hexadezimal).

Ein/Ausgabe
[E ROOT
~[+] ANALOG_COMPARATOR
[+] SPT
-[+] EXTERNAL_INTERRUPT
-[*] TIMER_COUNTER_@
-{+] TIMER_COUNTER_1
-[*] TIMER_COUNTER_2
-[+] USART
W[5 TWI
-[+] WATCHDOG
®B| FORTE
=138 PORTE = B0 :POrt B Data Reqister 1
-------- @ PORTE® =8 ; Port B Data Register bit
i 1 PORTBL =0 ; Port B Data Register bit
-2 PORTBZ =8 ; Port B Data Register bit
-3 PORTE3 =0 ; Port B Data Register bit
-4 PORTE4 =8 ; Port B Data Register bit
-5 PORTBS =0 ; Port B Data Register bit
- & PORTEG =8 ; Port B Data Register bit
Basess 7 PORTET =1 ; Port B Data Register bit
.[+] 37 DDRB = ff ;Port B Data Direction Reg
-[+] 36 PINB = 00 ;Port B Input Pins
.[+] PORTC
-{+] PORTD
.[+] EEPROM
-[+] CPU
-[*] AD_CONVERTER

Die Ports und Bits sind zu Funktionsgruppen, in einer Baumansicht integriert. Wird ein Port
angeklickt, erscheint ein Dialog, zur Eingabe eines neuen (Hex)-Wertes.

Wird ein Bit angeklickt (erhdlt es den Fokus), wird es getoggelt. Soll es zuriicktoggeln, muss der
Fokus erstmal woanders hin (die Gruppe anklicken, das bewirkt nichts), bevor das Bit wieder
angeklickt werden kann. Vielleicht féllt mir dafiir noch was besseres ein..

Starter Erzeugen

Benutzer von Gnome (und kompatiblen) Desktops, konnen mit "File->Create Starter" eine
Desktopdatei in ihrem personlichem Applications-Verzeichnis erzeugen. Damit lédsst sich dann die
Erweiterung ".obj" mit dem Programm verkniipfen, und die Dateien lassen sich dann mit
Doppelklick 6ffnen.



OO Anwendung auswihlen

EmpFohlene Anwendungen

_&
ﬂxvi32

Alle Anwendungen anzeigen

Neue Anwendungen suchen

Abbrechen Auswahlen

Definitionsdateien

Der Simulator, sowie die Benutzeroberfldache, wird durch Dateien gesteuert, welche den zu
simulierenden Prozessor beschreiben. Diese wurden automatisch aus den Assembler-Includedateien
abgeleitet, mussten aber manuell nachbearbeitet werden. Hier ein Beispiel fiir die, fiir den
EEPROM zustdndigen Register in der Rohdatei:

* k Kk kK EEPROM R I I A IR db b b b b b b 4 dE db db Sb Ib b b b 4

; EEDR - EEPROM Data Register

.equ EEDRO = 0 ; EEPROM Data Register bit O
.equ EEDRI1 = 1 ; EEPROM Data Register bit 1
.equ EEDR2 = 2 ; EEPROM Data Register bit 2
.equ EEDR3 = 3 ; EEPROM Data Register bit 3
.equ EEDR4 = 4 ,; EEPROM Data Register bit 4
.equ EEDRS = 5 ,; EEPROM Data Register bit 5
.equ EEDRG = 6 ; EEPROM Data Register bit 6
.equ EEDR7 = 7 ; EEPROM Data Register bit 7
; EECR - EEPROM Control Register

.equ EERE = 0 ; EEPROM Read Enable

.equ EEWE = 1 ; EEPROM Write Enable

.equ EEMWE = 2 ,; EEPROM Master Write Enable
.equ EEWEE = EEMWE ; For compatibility
.equ EERIE = 3 ; EEPROM Ready Interrupt Enable

Man sieht hier eine Abschnittsiiberschrift (mit den Sternen), die beiden Uberschriften mit den
Registernamen (die Adressen wurden weiter oben definiert), sowie die Definitionen der Bits.

Was hier fehlt, sind die beiden Register EEARH und EEARL, die oben zwar definiert, hier aber
nicht referenziert werden.

In der aufbereiteten Definitionsdatei sieht das dann so aus:

Group EEPROM
Port EEDR=3D ;EEPROM Data Register
Bit EEDRO=0 ; EEPROM Data Register bit O



Bit EEDR1=1 ; EEPROM Data Register bit
Bit EEDR2=2 ; EEPROM Data Register bit
Bit EEDR3=3 ; EEPROM Data Register bit
Bit EEDR4=4 ; EEPROM Data Register bit
Bit EEDR5=5 ; EEPROM Data Register bit
Bit EEDR6=6 ; EEPROM Data Register bit
Bit EEDR7=7 ; EEPROM Data Register bit
Port EECR=3C ;EEPROM Control Register
Bit EERE=0 ; EEPROM Read Enable
Bit EEWE=1 ; EEPROM Write Enable
Bit EEMWE=2 ; EEPROM Master Write Enable
Bit EERIE=3 ; EEPROM Ready Interrupt Enable
Die beiden Zeilen

~N o O s W DN B

Port EEARL=3E

Port EEARH=3F
konnten nicht zugeordnet werden und erscheinen in der Gruppe "verwaiste Ports". Diese verwaisten
Ports habe ich dann manuell in die (hoffentlich) richtigen Gruppen verschoben.

In der Mehrheit der Bausteine betraf dies den Stackpointer (SPL und SPH), die in die Gruppe CPU
gehoren, wie genannt, die EEPROM-Adressen, UART-Baudratenregister und Register von Timern.

An der Reihenfolge der Gruppen hab ich nichts geédndert, die sind noch in der, von ATMEL
vorgegebenen Reihenfolge. Wer mdchte, kann die gern dndern. Ebenso kénnen meiner Meinung
nach, auch etliche Bitdefinitionen entfernt werden (im EEDR, zum Beispiel, wird man eher selten
einzelne Bits ansprechen).

Dies habe ich fiir die Bausteine erledigt, die ich fiir gebrauchlich und relevant halte. Fiir die Dateien
im Unterordner "low_prio" ist dies noch nicht geschehen. Dies hole ich bei Bedarf nach, teilweise
miisste ich mir dafiir auch erst Datenblatter runterladen, da ich die Bausteine und ihre Architektur
nicht kenne.

Einstellungen

Das Programm speichert seine Einstellungen unter SHOME/.config/avrsim.conf (GNU/Linux)
beziehungsweise %userprofile%\avrsim.ini (MS-Windows).

Sollte das Programm nicht mehr korrekt starten, oder sich sonst unerwartet verhalten, kénnen diese
Dateien geldscht werden, das Programm verhilt sich dann "wie neu".

Aussicht

Als Nachstes, mochte ich mich mit dem ELF-Dateiformat beschéaftigen, welches vom AVR-GCC
(LD) ausgegeben wird. Ansonsten werden erste Periperiefunktionen integriert (EEPROM)...

Chronik

04.03.2017  Ansicht der Peripherie iiberarbeitet (Baumansicht), Arbeitsregister haben jetzt
Eingabefelder bekommen. Definitionsdateien wurden neu erstellt und angepasst.
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